
5 Displaying Images with Image 
Manager
This chapter describes how Image Manager is used to control all aspects of 
image display, to manage image files, to open images in various formats, and 
to save images where changes occur. All MicroStation Descartes imaging tools 
require these capabilities of Image Manager as foundation tools. 
Overview
Image Manager provides a set of features for controlling the 
display of images and for managing Image files.

In this chapter, you will learn how to use the Image Manager 
dialog box to manage a list of images for each of the MicroStation 
views, especially with the following tools:

• Select Images/Active Image

• Images On

• Images Off

• Bring Images to Front

• Send Images to Back

• Fit Images to View

• Fit All Images to View

• Actual Image Resolution (1:1)

• Close Images

• Close All Images

You can copy a list of images from one view to others with the 
following functions:

• Apply To

• Apply To All
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5 Displaying Images with Image Manager
Overview
You will learn how to use various dialog boxes to create a new 
image, to open one or several images, to save images to files, and 
all functions for managing Image files such as:

• New Image

• Open Images

• Save Image

• Save Image As 

Various properties of images can be displayed or edited with the 
following dialog boxes:

• General Image Properties

• Color Table Editor

• Image Location Editor

• Histogram Display

Finally, you will see how to set the view attributes with the View 
Image Attributes dialog box, which can be accessed from the 
Settings menu of Image Manager. With this dialog box (see “View 
Image Attributes dialog box” on page 5-30), you can decide 
which of the following capabilities are supported in each of the 
MicroStation views:

• Image Border (to graphically highlight selected images or the 
active image in a view)

• Images (to allow or inhibit the display of images in a view)

• Rotation (to allow images to display with a rotation in a view)

• Transparency (to allow or inhibit the transparency capability 
in a view)

• Translucency (to allow or inhibit the translucency capability 
in a view)
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Image Manager dialog box
Image Manager dialog box
Images displayed with Image Manager are fully integrated into 
MicroStation. You can use MicroStation’s drawing and annotation 
tools when images are open in any number of views, as well as 
any other MicroStation third party application.

Image Manager displays data in 2D with both 2D and 3D design 
files.

Image Manager can display various types of images, such as 1 bit 
monochrome images, gray scale images with up to 256 shades of 
gray, or color encoded images with up to 256 colors. 

You can open images of various formats with an unlimited 
number of colors or gray shades. However, when you open such 
images, they will be converted to 256 color or 256 shade images. 
Several image formats are transparently supported. See “Open 
Images dialog box” on page 5-19.

In addition to the title bar (where the name of the current project 
is displayed, see “MicroStation Descartes Projects” on page 3-4), 
the Image Manager dialog box comprises two main parts:

• The menu bar, which is fully described in Chapter 4

• The image list box, occupying the lower part of the 
dialog box

You can resize the list box by dragging the bottom edge of the 
dialog box. You can display any number of lines of the list. The 
size of your screen is the only constraint for the maximum 
number of lines you can display.

When the number of images in a list is larger than the number of 
lines displayed, you can scroll up and down with the scroll bar.

✍ The open/close status of the Image Manager dialog box is saved 
with a project.

Image Manager dialog box

Image list box—images of
active view
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Managing image lists
You can manage up to eight lists of images, one for each of the 
eight MicroStation views. The list box displays a list of images that 
belong to the current view. Any number of images can be 
included in a list. The same image can belong to several lists. 
Each individual image listed and displayed in a view can have a 
different resolution or a different color type. 

You can consider the list of images as a stack seen downward 
from an upper position. Overlapping images can hide or be 
hidden by others. If images are moved upward or downward, or 
if more images are inserted in a stack, the corresponding view 
updates to reflect the new staking situation. 

You can add existing images to a list with the Open Images dialog 
box, or create an image and add it to a list with the New Image 
dialog box. You can remove from a list by using the Close Images 
or the Close All Images commands or tools.

Images in a view can be turned off with the Images Off 
command, or turned back on with the Images On command. 
When off, the name of the image stays in the corresponding list, 
but the image does not display in this view. The “X” mark on the 
left of the image name means this image is on. An empty field 
indicates off. An image whose status is on is visible or likely to be 
displayed when you update or redraw a view. When you change 
the on/off status of an image, the corresponding view updates.

You can also control the transparency or translucency of 
individual images in a view (see “View Image Attributes dialog 
box” on page 5-30). The “t” mark on the right of the image name 
in a list is for an image with transparency on. The “r” mark is for 
an image with translucency on.

The uppercase “R” indicates a Read-Only image.

✍ The lists of images are saved with a project. For each image in a 
specific view, the on/off visibility status and the Transparency/
Translucency parameters are also saved.

Assigning one view to the list box
Only one list can be controlled at a time. You can choose the 
target view from the Display Control for View option menu. Only 
the MicroStation views that are open can be accessed from this 
option menu at a given time. The Display Control for View option 
menu displays the number of the view that is active. The list box 
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Applying a list of images to other views
under this option button displays the list of images that belong to 
this view.

Applying a list of images to other views
Choose the following items from the Display menu to apply a list 
of images to other views. After a list is copied to another view, it 
can be managed as an independent list.

Apply to…

Copies the present list of images into the list of another view or 
other views. Choose this option to open the Apply to dialog box 
and select the destination views by turning on the corresponding 
check buttons. You can only access open MicroStation views with 
this dialog box.

Apply to All

Copies the present list of images into the lists of all other open 
views.

W The Apply to and the Apply to All options overwrite the 
destination lists. If you have not saved your lists in a project, be 
careful when using these features.

Contrast/Brightness controls
Contrast/Brightness control can be accessed either from the 
Image Manager > Display menu or, when working in the “dcartes” 
workspace, from the File > Image Display menu. To move the 
control, click on the dot and keep the data button depressed. 
Moving the dot modifies the Contrast or Brightness for the 
selected image. You can also move the dot by choosing a point 
on the circle and taking a data point. the dot moves to the 
position of the data point.

✍ Contrast/Brightness settings do not affect the image file and are 
not saved in a project.

Applies to specific views the
content of the active view.

The active view is set by
Display Control for

View option.
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Opening images
To open one or more images in a view, choose Open from the 
File menu or select the Open Images tool in the Image File tool 
box, and use the Open Images dialog box (see “Open Images 
dialog box” on page 5-19).

Creating new images
To create a new image and add it to a view, choose New from the 
File menu or select the New Image tool in the Image File tool box 
(see “New Image dialog box” on page 5-17).

Selecting images
When you open one or more images in a view, or when you 
create a new image in a view, they are added to the 
corresponding list and become selected. 

You can manually select or deselect one or more images from the 
list of the active view, or from the view itself.

Selected images are highlighted in two ways:

• The lines corresponding to the selected images in the list box 
are highlighted the usual way.

• The selected images in the corresponding view are displayed 
with a solid border. 

✍ You can have any number of images (including none) selected at 
one time in each view.

➤ To select one image from a list

1. Click the name of an image in the list box. 

The selected image is highlighted in both the list and the 
corresponding view. All other images are then deselected. 
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Selecting images
✍ Selecting an image is useful for checking which image 
corresponds to which file name, since both the list and the view 
will show the highlighted image.

➤ To select one image in a view

1. In the Image Control tool box, select the Select Images / 
Active Image tool.

2. Click the image you want to select in the appropriate view.

The selected image is highlighted in both the view and the 
corresponding list. All other images are then deselected.

➤ To select several consecutive images from a list

1. Click the name of the first image in the list box.

2. Hold down the <Shift> key and click the name of the last 
image.

The first image, the last image, and all names in between will 
be selected. 

➤ To select additional images from a list

1. Hold down the <Ctrl> key and click the names of the images 
you want to select. 

The selected images are highlighted one by one in both the 
list and the corresponding view. If you control-click names 
which are already highlighted, they are deselected.

➤ To select additional images in a view

1. In the Image Control tool box, select the Select Images/Active 
Image tool.

2. Control-click the images you want to select. (Control-click 
means to hold down the <Crtl> key while clicking the Data 
button.)

The selected images are highlighted in both the view and the 
corresponding list. If you control-click images which are 
already selected, they are deselected.
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➤ To deselect images

1. Hold down the <Ctrl> key and click the names of the images 
you want to deselect in the list box.

OR

1. In the Image Control tool box, select the Select Images / 
Active Image tool.

2. Control-click the images you want to deselect. (Control-click 
means to hold down the <Crtl> key while clicking the Data 
button.)

➤ To deselect all images in a view

1. Click in the list box on any name to deselects all names but 
that one.

2. Deselect this name with a control-click.

OR

1. In the Image Control tool box, select the Select Images / 
Active Image tool.

2. Click where there is no image in the appropriate view.

All image are deselected in this view.

Choosing the active image
The active image is the one that can be edited or used. More 
generally, it is used by all functions that are likely to modify any 
aspect of an image: the description, the location, the color table, 
the transparency or translucency parameters or status, or the 
image pixels as such. 

Here are the functions and utilities that apply only to the active 
image:

• The Save and Save As commands

• The image properties commands

• Contrast Stretch

• Density Slicing

• Image Channels

• Transparent Colors

• Translucent Colors
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Choosing the active image
Most tools from the following tool boxes apply only to the active 
image:

• Clean Up

• Color Filter 

• Copy / Paste

• Erase 

• Image Transform

• Local Transform

• Paint

• Text / Cells

• Undo / Redo 

• Vectorize

The active image provides its color lookup table for all displayed 
views.

You can choose the active image from one of the lists of images, 
or graphically from a view.

The active image is highlighted in two manners:

• The name of the active image is written with the element 
highlight color in the list box. If the active image is selected, 
the line corresponding to the active image in the list box is 
highlighted in the element highlight color.

• The active image is displayed in the corresponding view with 
a dashed border with the element highlight color around it.

✍ To change the Element Highlight Color, use the Color page of the 
Design File Settings dialog box that you can access by choosing 
Design File from the Settings menu of MicroStation.

✍ You can have a maximum of one active image at a time for all 
views.

✍ In a situation where:

• Only one view is open;

• Only one image is loaded or there is only one image 
selected; or

• No image is already set as active;
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all editing tools automatically make an image active. Otherwise, if 
there is no active image when you try to use an editing tool, you 
are notified.

➤ To choose the active image from a list

1. Double-click the name of an image in the list box.

OR

1. Select an image in the list box.

2. Choose Set Active Image from the Edit menu.

The active image is highlighted in all lists and all views where 
it is present. 

➤ To choose the active image in a view

1. In the Image Control tool box, select the Select Images / 
Active Image tool.

2. Double-click the image you want to set as active in the 
appropriate view.

The active image is highlighted in all views and all lists where 
it is present.

➤ To choose no active image

1. Double-click the name of the active image in the list box.

OR

1. In the Image Control tool box, select the Select Images / 
Active Image tool.

2. Double-click where there is no image in any view.

Moving images forward or backward
One or more images can be moved together to the top of the list 
(or stack) of images, or to the bottom.
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Moving images forward or backward
➤ To bring a selection of images to the front of a view

1. Choose the appropriate view with the Display Control for 
View option menu.

2. Select one or more images in the list or graphically in the 
corresponding view.

3. Choose Bring to Front from the Display menu.

or

In the Image Control tool box, select the Bring Images to 
Front tool and identify the target view.

All the selected images move to the top of the list, in the same 
order as they were originally displayed.

➤ To bring individual images to the front of a view

1. Deselect all images in the appropriate view.

2. In the Image Control tool box, select the Bring Images to 
Front tool.

3. Identify the view where you want to move images.

4. Identify the images you want to move by clicking on them in 
this view.

All identified images move one by one to the top of the stack 
and to the top of the corresponding list.

➤ To send a selection of images to the back of a view

1. Choose the appropriate view with the Display Control for 
View option menu.

2. Select one or more images in the list or graphically in the 
corresponding view.

3. Choose Send to Back from the Display menu.

or

In the Image Control tool box, select the Send Images to Back 
tool and identify the target view.

All the selected images move to the bottom of the list, in the 
same order that they were originally displayed.

➤ To send individual images to the back of a view

1. Deselect all images in the appropriate view.

2. In the Image Control tool box, select the Send Images to Back 
tool.
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3. Identify the view where you want to move images.

4. Identify the images you want to move by clicking on them in 
this view.

All identified images move one by one to the bottom of the 
stack and to the end of the corresponding list.

Turning images on or off
One or more images can be turned on or off at the same time.

➤ To turn on images

1. Select one or more images, either graphically in a view or in 
the corresponding list.

2. Choose Images On from the Display menu.

All the selected images will be turned on (if they were already 
on, they remain unchanged).

➤ To turn off images

1. Select one or more images, either graphically in a view or in 
the corresponding list.

2. Choose Images Off from the Display menu.

All the selected images will be turned off (if they were 
already off, they remain unchanged).

Inspecting or editing image properties
With the File > Properties sub menu, you can explore, display or 
change various properties of images. All Properties functions 
apply to the active image.

➤ To display the general properties of an image

1. Choose the desired image as active, either graphically in a 
view or in the corresponding list.

2. Choose Properties from the File menu.
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Inspecting or editing image properties
3. Choose General from the Properties sub menu.

The General Image Properties dialog box displays with the 
general properties of the active image. When you finish 
inspecting the properties, click Done.

➤ To display or change the color table of an image

1. Choose the desired image as active, either graphically in a 
view or in the corresponding list.

2. Choose Properties from the File menu.

3. Choose Color Table from the Properties sub menu.

The Color Table Editor dialog box opens and you can inspect 
or modify the color table of the active image. See “Color 
Table Editor dialog box” on page 6-5.

➤ To display or change the location of an image

1. Choose the desired image as active, either graphically in a 
view or in the corresponding list.

2. Choose Properties from the File menu.

3. Choose Location from the Properties sub menu.

The Image Location Editor dialog box opens and you can 
inspect or modify the georeference parameters of the active 
image. See “Image Location Editor dialog box” on page 5-27.

➤ To display and explore the histogram of an image

1. Choose the desired image as active, either graphically in a 
view or in the corresponding list.

2. Choose Properties from the File menu.

3. Choose Histogram from the Properties sub menu.

The Histogram Display dialog box opens and you can 
explore the histogram of the active image. See “Histogram 
Display dialog box” on page 6-2.

General Image Properties
dialog box
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Fitting images to a view
You can fit one image, a selection of images, or all images to a 
view at a time.

➤ To fit a selection of images to a view

1. Choose the appropriate view with the Display Control for 
View option menu.

2. Select one or more images in the list or graphically in the 
corresponding view.

3. Choose Fit Images to View from the Display menu.

or

In the Image Control tool box, select the Fit Images to View 
tool and identify the target view.

All data in the specified view displays at a new scale, in such 
a manner that all the selected images fit within the extent of 
this view.

➤ To fit one individual image to a view

1. Deselect all images in the appropriate view.

2. In the Image Control tool box, select the Fit Images to View 
tool.

3. Identify the target view.

4. Identify the image you want to fit by clicking on it in this 
view.

All data in the specified view displays at a new scale, in such 
a manner that the selected image fits within the extent of this 
view.

➤ To fit all images to a view

1. Select the appropriate view with the Display Control for View 
option button.

2. Choose Fit All Images to View from the Display menu.

OR

1. In the Image Control tool box, select the Fit All Images to 
View tool.

2. Turn ON or OFF the Fit All Images and Design elements from 
the Tools Settings.
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Displaying an image in full resolution
3. Identify the view where you want to fit images by clicking on 
this view.

All data in the specified view displays at a new scale, in such 
a manner that all the images fit within the extent of this view.

Displaying an image in full resolution
With the Actual Resolution (1:1) item, you can display an image at 
full resolution and impose the corresponding scale to the view.

➤ To display an image at 1:1 resolution

1. Select one (and only one) image, either graphically in a view 
or in the corresponding list.

2. Choose Actual Resolution (1:1) from the Display menu.

or

Select the Actual Image Resolution (1:1) tool from the Image 
Control tool box.

OR

1. Deselect all images in the appropriate view.

2. In the Image Control tool box, select the Actual Image 
Resolution (1:1) tool.

3. Identify the target view.

4. Identify the desired image by clicking on it in this view.

All data in the specified view updates at a new scale, in such 
a manner that the selected image displays at full resolution in 
this view.

Saving images
You can save changes that were made to the active image or save 
the active image under a new name.

➤ To edit an image and save changes

1. Choose the active image, either graphically in a view or in the 
corresponding list.

2. Use any editing tool to modify this image (for instance, 
speckle removal).
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3. Choose Save from the File menu.

The active image is saved as it is now, with the same 
properties, the same name and in the same file.

➤ To save an image under a new name

1. Make the desired image active, either graphically in a view or 
in the corresponding list.

2. Choose Save As from the File menu.

3. Use the Save As dialog box to specify the new parameters.

The active image is saved with the parameters specified in the 
Save As dialog box, in a new file, and with a new name.

Closing images
One or more (or all) images can be closed at the same time. For 
each image that changed, you are asked if you wish to save the 
changes.

➤ To close a selection of images

1. Select one or more images, either graphically in a view or in 
the corresponding list.

2. Choose Close from the File menu.

All the selected images are removed from the current view 
and their names are removed from the corresponding list.

➤ To close all images in all views

1. Choose Close All from the File menu.

All images will be removed from all views and their names 
are removed from all the lists.
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New Image dialog box
Used to create a new HMR image. When you create an image, its 
name is added to the top of the Image Manager image list for the 
active view and it is set to on. The image displays in the active 
view, assuming that Images is turned ON in the View Image 
Attributes dialog box.

File Name
Used to specify and display the name of the HMR image file. To 
select the output file, click Select on the right and use the 
standard MicroStation file selection dialog box. 

Same As
Used to specify and display the name of an existing HMR image 
that you want to use as a template for a new image. To select the 
template image file, click Select.

The parameters of the image display in the appropriate text 
boxes, where you can edit them.

If you edit parameters, you can reset all the parameters of the 
template image by pressing the Reset button.

Pixel Type
Used to specify the type of the new image. The options are 2 
Colors and 256 Colors.

Data Compression
Used to choose between None, PackBits, CCITT3, CCITT4, and 
Deflate data compression options.

New Image dialog box
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Background Color
Used to specify and display the background color for the new 
blank image. To select or define the color, click on the Edit 
button.

Description
Used to enter and edit a short description for the image (up to 
128 characters).

Rows and Columns
Used to specify the size of the new HMR image in rows (number 
of lines) and columns (number of pixels per line).

A Lock box appears on the right when Interactive is chosen from 
Place Mode. It can be used to lock both Rows and Columns once 
desired values are entered. When this lock is on, the 
corresponding parameters cannot be changed during the 
Interactive Place process.

Pixel Size
Used to specify the size of each pixel of the image, in working 
units.

Place Mode
Used to choose the way the extent of the new image will be 
placed. The options are Interactive and Location.

If you choose Location, the Location button becomes available 
and you can place the image extent by using the “Image Location 
Editor dialog box” on page 5-27.

If you choose Interactive, you can place the image extent by 
defining a rectangle interactively in a view. The locks connected 
with Rows and Columns or Pixel Size govern the place 
mechanism, as follows:

• As long as both locks are off, the interactive mechanism is not 
available. 

• If only Rows and Columns are locked, clicking OK starts the 
interactive mechanism. The rectangular extent is defined with 
two data points. The numbers of rows and columns are 
preserved, as well as the aspect ratio of the image. The pixel 
size is modified to fit the rectangle. The new image is created 
after the second data point is entered.

• If only Pixel Size is locked, clicking OK starts the interactive 
mechanism. The rectangular extent is defined with two data 
points. The pixel size is preserved. The numbers of rows and 
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columns are modified accordingly. The new image is created 
after entering the second data point.

• If both locks are on, clicking OK starts the interactive 
mechanism. The place command then becomes a move. The 
image extent is displayed in outline form and can be moved 
with the cursor. Entering a data point creates and places the 
new image. 

Location
Used to open the Image Location Editor dialog box. (See “Image 
Location Editor dialog box” on page 5-27.)

OK
Click OK to close the dialog box and create the new blank image 
with the specified parameters, or to place the new image 
interactively and create it.

Cancel
Click Cancel to close the New Image dialog box and not create a 
new image.

Open Images dialog box
The Open Images dialog box is used to open one or more images 
in one or more views at a time. When images are opened, their 
names are added to the top of the image list for the specified 
views. They are selected, marked on, and displayed in the 
specified views.

Open Images dialog box
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✍ If images do not display as expected in a view, do the following:

• Make sure the Images check box is turned on in the Image 
View Attributes dialog box;

• Select the Fit Images to View tool and identify the view.

Image Selection

This group is used to choose a disk, a directory, the type of 
images to be listed, and to select one or more images to be 
opened.

Drives

Used to choose the disk where images are stored.

Directories

Used to choose the path to access the images.

List Files of Type

Use this option menu to see the list of all image formats or types 
that are supported by Image Manager. Choose a format or a type 
and all corresponding images in the specified disk and directory 
are listed in the Files list box.

Add Converted Types to the Files List

When off, the only options present in the List Files of Type option 
button are:

• HMR (*.hmr)

• All Files (*.*) 

When on, all other supported formats are added in the List Files 
of Type option button. 

For better performance at all levels, it is recommended that you 
use the HMR format. See “Image File Type Issues” on page 3-16.

Files

Use this list box to highlight one or more image names at a time.

To select an image name, click its name in the list box (this 
deselects all other names).

To select additional names, hold down the <Ctrl> key and click 
the names of the images you want to select. 
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To select consecutive names, hold down the <Shift> key and click 
the names of two images. These names and all names in between 
are selected.

To deselect images, hold down the <Ctrl> key and click the 
names of the images you want to deselect in the list box.

Views

Turn on the check box of the view or views where images will be 
opened.

The current view of Image Manager is proposed. Check the 
individual buttons or use the None or All buttons to turn toggles 
on or off.

OK

When you press OK, all images with their names highlighted in 
the File list box open in each of the specified views.

Image Preview

When on, a preview of an image is displayed in the Preview box 
as soon as its name is selected in the Files list box. If more than 
one name is selected at a time (for example by holding the 
<Shift> or the <Ctrl> keys), the last selected image is previewed. 
Actually, it is the one whose name displays in the box just above 
the Files list box.

Place Interactively

This toggle is inhibited and turned off when more than one image 
is highlighted in the Files list box. 

When it is ON and you click OK, you start the interactive 
mechanism to place and open the selected image. You are 
prompted to place the image interactively by defining a 
rectangular extent with two data points. The numbers of rows and 
columns are preserved, as is the aspect ratio of the image. The 
pixel size is modified to fit the rectangle. The image opens after 
entering the second data point.

After interactively placing an image, as in previous versions, the 
image is surrounded by handles (see figure 1). It is then possible 
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to shape (move, scale, rotate the image and change affinity angle) 
the image by selecting and moving the appropriate handle(s).

To select a handle move the cursor over the handle and click the 
data point button. Once a handle is selected, the image can be 
shaped by moving the pointer. A rubberband outline is drawn to 
show the new shape of the image as the handle is moved. Click 
the data button again to end the shaping and the image will be 
updated. 

✍ To release a handle (cancel), simply select Reset.

✍ The Undo/Redo feature stores the operation for each handle. 
Therefore, if an image is modified by using two handles, two 
Undo or Redo operations are necessary to revert the image to its 
original state.

As shown in figure 1 (above), multiple handles are available to 
shape the image. There are standard handles that allow scaling, as 
well as affinity, rotation and origin handles. 

Scaling Handles

There are eight scaling handles. These handles are recognized by 
the squares appearing around the edge of the image. Scaling 
Handles are positioned at the corners, sides and top of an image. 
When manipulating these handles, the image scales about the 
Origin Handle. 

Figure 1
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Rotation Handles

There are four rotation handles. These handles are recognized by 
the arc shape and double ended arrows. Rotation Handles are 
positioned at the corners of an image. When manipulating these 
handles, the image rotates about the Origin Handle. 

Affinity Handles

There are four Affinity handles. These handles are recognized by 
the straight double ended arrows. Affinity handles are positioned 
at the center on the side edges of an image. When manipulating 
these handles, the opposite image edge remains unchanged and 
the three other edges are moved according to the handle’s new 
position.

Moving the Image

The image may be moved by positioning the pointer anywhere 
over the image and clicking the data button. The image is then 
attached to the pointer and displayed as an outlined rubberband. 
Position the outline at the new location and enter a data point to 
confirm the new position. The image will be updated and 
displayed at its new position.

Tools Settings Fields

The tool settings dialog box for the Open Image Interactively 
feature displays fields for:

• The image origin

• Pixel size or scale factor

• Rotation

• Affinity 

Figure 2 highlights the new fields available in each mode, Pixel 
Size and Scale Factor. 

Figure 2

Scale Factor OptionsPixel Size Options
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The fields at the beginning of the Place Interactively process 
display the original settings for the image being opened/placed. 
As a handle is moved, the values displayed in these fields are 
updated to reflect the position of the handle, therefore providing 
you greater control. It is also possible to directly key in the values 
instead of using the handles.

✍ Each keyed in value is considered by the Undo/Redo buffer as 
one Undo/Redo operation.

Tools Settings > Scale Factor

The option button of the tool settings allows two choices, Pixel 
Size and Scale Factor. Previous versions allow the image to be 
scaled by specifying a Pixel Size. MicroStation Descartes Version 7 
offers a new method of scaling by specifying a Scale Factor. When 
Scale Factor is selected, the Tools Settings dialog box displays as 
shown in Figure 2 under Scale Factor Options. By using the scale 
of the image and the DPI the image was scanned at, the Pixel Size 
will be automatically calculated and applied.

The following equations is used to establish the relation between 
the Pixel Size VS, the Scale Factor, and Scan DPI:

Pixel size in X = (1 / dpi in X) * scale factor

Pixel size in Y = (1 / dpi in Y) * scale factor

✍ It should be noted that the Pixel Size lock is synchronized with 
the Scanning Resolution lock. In other words, when the Scale 
Factor is “locked,” the Scan Resolution is also “locked.”

However, when executing interactive placements and scales, 
using handles the following guidelines and restrictions should be 
observed:

• Always modify the scale factor setting. 

• Since “non square” pixels are supported, it is possible to 
change only one axis when the lock is opened. 

In such case, the scale factor reflects the interactive scale, and 
for consistency reasons, the scanning resolution is changed 
for the other axis. 

• The lock is in position when the pixel is square. This is a 
default setting.

• When scaling an image “proportionally” (with the corners 
scale handles or with the edge scale handles when the lock is 
closed), the scale factor is changed. 

• When scaling the image “not proportionally” (with the edges 
scale handles when the lock is opened), the scale factor is 
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changed based on the axis that has been modified and the 
dpi is changed for the other axis. 

✍ If an image has no georeference, you will be asked if you want to 
place the image interactively.

Save As dialog box
Used to save the active image under a new name. The name of 
the new image replaces the old file name in the Image Manager 
image list for the active view.

The Save As dialog box allows you to convert the active image 
into any format and type before saving it to disk.

Drives

Used to choose the disk where the output image will be stored.

Directories

Used to choose the path where the image will be saved. 

Name

Use this box to enter a new name. 

Output

This group is used to specify how you want to save the active 
images. See Output, on page 14-2, for comparison.

Save As dialog box
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Type

Used to specify the generic format for the output image (for 
example, HMR, TIFF, etc.). The list of available formats is given in 
the Image File Formats Table (see “Image File Formats Table” on 
page 15-10).

Pixel Type

Used to specify the specific format, or color mode, for the output 
image. The list of available types is adjusted to each format, as 
you can see in the Image File Formats Table (see “Image File 
Formats Table” on page 15-10).

Data Compression

Used to specify the type of compression to be used for the output 
image (for example, Deflate, PackBits, CCITT3). The list of 
available compression types is adjusted to each format, as you 
can see in the Image File Formats Table (see “Image File Formats 
Table” on page 15-10).

Options

When more parameters need to be specified, this button becomes 
available and opens a specific dialog box for this purpose. For 
example, if you choose a TIFF format for the output, you have the 
option to tile the image. The list of available options is given in 
the Image File Formats Table (see “Image File Formats Table” on 
page 15-10).

Color Compression

Used to open the Color Compression Setup dialog box (see 
“Color Compression Setup dialog box” on page 6-16). This button 
is not accessible if either the input image or the output image are 
two-color.

Use the Color Compression Setup dialog box to specify the 
maximum number of colors or gray levels, and the color 
compression encoding key to be used.

OK

When you press OK, the active image will be converted and 
saved into the format or type you specified in the Output group.
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Image Location Editor dialog box
When opened from the Location item of the File > Properties 
menu, this dialog box is used to enter, edit, or review location 
parameters contained in the header of the active image. You can 
also access this dialog box from the New Image dialog box. In 
both situations, the file name of the specified image displays in 
the title bar of the dialog box.

Description
Use the Description field to enter a short description of the image 
(up to 128 characters).

Origin
Use the X and Y fields to enter, edit, or review the origin of the 
image, according to the specified system of Cartesian coordinates 
for the image. The X and Y values are the coordinates of the 
lower left corner of the image, in working units. These fields can 
be edited and are independent of all other fields.

Dimension
The Dimension is the size or area of the image in the specified 
system of coordinates for the image. The X and Y values are 
given in working units. 

If the image exists, you can review but not edit these parameters. 
If you change the pixel size, the image dimension values are 
adjusted accordingly (equal to the pixel size times the number of 
pixels - in X or Y).

Figure 3 Figure 4
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If the image does not exist, the Dimensions box can be used to 
enter the X and Y image dimensions. Then, the number of pixels 
is adjusted accordingly in X and Y, but the pixel size remains 
unchanged. If you change the pixel size, the image dimensions 
remain unchanged. If you change the number of pixels, the image 
dimensions adjust. Since the image dimension value in X or Y is 
always equal to the pixel size times the number of pixels and 
since this number is an integer, the X and Y dimensions adjust 
automatically to the nearest values that agree with the equation.

Pixel Size
The field displays the size of each pixel of the image, in working 
units. You can edit it but it never adjusts automatically.

In normal editing mode, use the Pixel Size box to review or to 
edit this parameter. If you change the pixel size, the image 
dimensions adjust automatically and the number of pixels remains 
unchanged.

When creating a new image, use the Pixel Size box to enter or 
edit this parameter. If you change the pixel size, the number of 
pixels in X and Y adjust automatically and the image dimensions 
remain unchanged, except for the small adjustment explained 
above.

The pixel size that you enter should be carefully calculated and 
you must consider the scale of the imagery as well as the 
resolution of the scan. The pixel size is expressed in the Working 
Units that you have defined in MicroStation. In order to compute 
the pixel size, you must know the scale of imagery (i.e., 1:5000) 
and the scan resolution of one pixel (i.e., 1/300 inch if the scan 
resolution is 300 dpi, or 84.6 Micron).

➤ To compute the pixel size for square pixels

1. Scale of Imagery x Scan Resolution of a Pixel = Pixel Size. 
For example, if the scale is 1:5000 and the scan resolution is 
300 dpi, then 5000 x (1/300) = 16.66 inches.

2. Convert the pixel size from the scanning unit to the proper 
Working Units (master:sub:positional). If Master Units are 
Feet, Subunits are Inches, and there are 100 Positional Units 
per Inch, then 16.66 inches = 1 MU:4 SU:66 PU or 1:4:66.

Scale Factor
Use the Scale Factor option as an alternative to the Pixel Size 
option. In this mode, the pixel size is automatically calculated. In 
this mode, you must know the scale of the raster document and 
the resolution at which it was scanned. By entering these two 
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variables, the image will be properly scaled where the pixel size 
will be calculated using the values entered for Scale and Scanned 
Resolution.

Number Of Pixels
Displays the size of the image in columns (X value) and rows (Y 
value). The X and Y values are integers.

In normal editing mode, use the Number of Pixels box to review 
the parameters. You can edit other fields here as well.

When creating a new image, use the Number of Pixels box to 
enter or edit the number of columns and rows required for the 
new image. Then, the image dimensions adjust accordingly in X 
and Y, but the pixel size remains unchanged. 

If you change the pixel size or the image dimensions, the number 
of pixels adjusts accordingly. It is always equal to the nearest 
integer approximating the image dimension divided by the pixel 
size (in X and Y separately).

For the reason explained above, you can automatically adjust the 
X and Y dimensions to the nearest values that agree with this 
equation when the number of pixels is adjusted in X or Y.

Rotation
Use this field to change the rotation factor applied to the image. 
The value is stored into the image transformation matrix.

Affinity
Use this field to change the affinity factor applied to the image. 
The value is stored into the image transformation matrix.

File Size
Displays the size of the image file in bytes. It changes with the 
number of pixels in X or Y.

OK
If you are satisfied with the current parameters, click OK. The 
image header updates and the Image Location Editor dialog box 
then closes.

Cancel
If you wish to exit, click Cancel. The Image Location Editor dialog 
box then closes.
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View Image Attributes dialog box
The View Image Attributes dialog box provides options to choose 
what is supported in each of the MicroStation views:

• Image Border (to graphically highlight selected images and/or 
the active image in a view)

• Images (to allow or inhibit the display of images in a view)

• Rotation (to allow images to be displayed with a rotation in a 
view)

• Transparency (to allow or inhibit the transparency capability 
in a view)

• Translucency (to allow or inhibit the translucency capability 
in a view)

✍ The ON/OFF status of each check button for each view is saved 
with a project.

View Number

Used to specify the view that acquires the attributes.

Apply

Used to apply the present attributes to the specified view by 
updating this view.

All

Used to apply the present attributes to all views.

Image Border

If you turn Image Border on for a view, all the selected images or 
the active image will be graphically highlighted in this view.

View Image Attributes
dialog box
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Selected images are highlighted with a solid border. The active 
image is highlighted with a dashed border in the element 
highlight color.

Images

Controls the visibility of all raster images in the specified view. 

Turning on the Images toggle for a view yields three effects:

• The on or off status of each image attached to the selected 
view is restored from memory.

• The status displays in the left column of the image list box. 
(See “Image Manager dialog box” on page 5-3.)

• The selected view is redrawn accordingly.

Turning off the Images toggle yields three effects:

• The on or off status of every image attached to the selected 
view is saved into memory.

• For all images, the off status (empty field in the left column) 
displays in the image list box.

• The selected view is redrawn accordingly, for example, with 
no raster images.

Rotation

Turns on or off the image rotation capability for the specified 
view. If on, images display in a view with a rotation. If off, images 
cannot display in a view with a rotation.

Transparency

Turns on or off the transparency for all raster images in the 
specified view. If the transparency mechanism is on for a view, all 
pixels of this image that have a color number that belongs to the 
transparency set do not display in this view. Overlapping images 
stacked underneath can be seen through holes made of 
transparent pixels.

The transparency mechanism functions for a given image only if:

• Transparent is on in the Transparent Colors settings box for 
this image. (See “Transparent Colors dialog box” on page 
6-18.)

AND

• Transparency is on for this view. 
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Turning on the Transparency for a view yields three effects:

• The transparent color list (if any) of every image attached to 
this view is restored from memory.

• The status “t” displays in the right column of the Image 
Manager list box.

• The specified view is redrawn accordingly.

Turning off the Transparency for a view yields three effects:

• The transparent color list (if any) of every image attached to 
this view is saved into memory.

• For all images that belong to the specified view, a dash (-) 
displays in the right column of the Image Manager list box.

• The specified view is redrawn accordingly, for example, 
without a transparent effect.

Translucency

Turning on or off the Translucency for a view turns the capability 
of displaying images with translucent colors on or off in this view.

Use the Translucent Colors dialog box to define translucent colors 
for an image (See “Translucent Colors dialog box” on page 6-20).

If the translucency mechanism is ON for a view, all pixels of this 
image that have a color number that belongs to the translucency 
set do not display in this view. You can see overlapping images 
and those stacked underneath can be seen through holes made of 
translucent pixels.

The translucency mechanism functions for a given image only if:

• Translucency is on in the Translucent Colors settings box for 
this image (See “Translucent Colors dialog box” on page 
6-20).

AND

• Translucency is on for this view. 

Turning on the Translucency for a view yields three effects:

• The translucent color list (if any) of every image attached to 
this view is restored from memory.

• The status “r” is displays in the right column of the Image 
Manager list box.

• The specified view is redrawn accordingly.
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Turning off the Translucency for a view yields three effects:

• The translucent color list (if any) of every image attached to 
this view is saved into memory.

• For all images that belong to the specified view, a dash (-) 
displays in the right column of the Image Manager list box.

• The specified view is redrawn accordingly, for example, 
without a translucent effect.

Image Control tool box
The Image Control tool box includes all necessary tools to select 
images and to control the display of images in the MicroStation 
view.

Select Images / Active Image tool
Use this tool for selecting images in MicroStation views or 
choosing the active image. Click to select; double-click on the 
image to make it active. Click an empty space for deselecting all 
images, double-click an empty space for no active image. See 
“Selecting images” on page 5-6 and “Choosing the active image” 
on page 5-8, for procedures.

Bring Images to Front tool
Displays the specified image on top of all other overlapping 
images in the specified view. 

➤ To bring an image to the top

1. Select Bring Images to Front.

2. Identify the target image in the target view.

Send Images to Back
Send Images to Back displays all other overlapping images in the 
view on top of the specified image.

➤ To position an image last

1. Select Send Images to Back.

2. Identify the target image in the target view.

Image Control tool box

Select Images / Active 
Image tool

Bring Images to Front tool

Send Images to Back tool
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Fit Images to View
Displays the specified images at a scale such that they fit in the 
view.

➤ To fit an image

1. Select Fit Images to View.

2. Identify the target image in the target view.

The location where the data point is entered also defines the 
new Window Center.

Fit All Images to View tool
Displays all visible images from the list associated with the view 
within the display window for the specified view. Optionally, also 
fits design files present in the view.

Fit All Images to View - Used with Fit All Images and 
Design Elements

When ON, Fit All Images and Design Elements allows a fit of the 
active design file and all displayed images (where the display 
attribute is turned on).

Fit Images to View tool

Fit All Images to View and the Tools Settings
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Actual Image Resolution (1:1) tool
Adjusts the scale of the view and displays the specified image 
without loss of resolution or zoom. This image displays with its 
actual resolution of 1:1 and the other images adjust accordingly.

When selected, Actual Resolution (1:1) prompts for a data point in 
a specific view. The location where the data point is entered in 
the view becomes the NEW “View Center.” Therefore, the data 
point should preferably be placed at a location on the image 
required to be viewed at a 1 to 1 resolution.

➤ To Actualize an Image and Set the New View Center

1. Select Actual Resolution (1:1)

2. If you are prompt to “Select an Image,” jump to step 3. Enter 
a data point anywhere in the view displaying the image you 
want to actualize.

3. If you are prompt to “Select an Image,” enter a data point on 
the image you want to actualize. The location of the data 
point becomes the new View Center.

4. The view updates displaying the image at a 1 to 1 resolution 
where the location of the data point on the image is displayed 
in the center of the view.

✍ If the selected image is too large to display entirely at this scale, 
only the center displays. It can be then panned as usual.

Image File tool box
The Image File tool box includes all necessary tools to manage 
Image files and to open the Image Manager dialog box.

If unsaved changes to an image are going to be lost, a warning 
message displays and prompts you to save the changes.

New Image tool
Used to open the New Image dialog box and to create a new 
image. See “New Image dialog box” on page 5-17.

Actual Image Resolution 
(1:1) tool

Image File tool box

New Image tool
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Open Images tool
Used to open the Open Images dialog box and to open one or 
more existing images in one or more views. See “Open Images 
dialog box” on page 5-19.

Save Image tool
Saves changes to the active image by updating the corresponding 
file.

Print Images tool
Used to open the MicroStation Plot dialog box. See “Descartes 
Plotting dialog boxes” on page 17-11.

Image Manager Dialog tool
Used to open the Image Manager dialog box. See “Image 
Manager dialog box” on page 5-3.

Open Images tool

Save Image tool

Print Images tool

Image Manager 
Dialog tool
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